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1 Introduction 

CADDY Conformity Test Software Overview 
CADDY Format Specification Compliance 
CADDY Project History 

 

1.1 CADDY Conformity Test Software Overview 

In order to use CADDY dossiers for exchange and archiving purposes, conformity to the CADDY 
format must be ensured. For this, a conformity test tool is needed. The conformity test software must 
report deviations from the CADDY format specification for a given dossier version on CD-ROM. 
CADDY Conformity Test Software scans CADDY CD sets for many conditions. For a description of 
the CADDY format see the CADDY format specification that is part of the distribution package. The 
CADDY Conformity Test knowledge base comprises over 100 known bugs and other problems. 

The Conformity Test Software was developed by Hewlett-Packard for the European Crop Protection 
Association (ECPA). It is distributed as freeware that should be used by everybody to check CD sets 
for CADDY conformity. 

Target Users 

The Conformity Test Software was developed for supporting CADDY experts from authorities and 
industry. It is a tool that can check if a given dossier version is CADDY compliant or not. 
Interpretation of the test results requires detailed knowledge of the CADDY format specification. 
Additionally, it is assumed that the user is familiar with Microsoft Windows. 

See also 
CADDY Format Specification Compliance 
CADDY Project History 
 

1.2 CADDY Format Specification Compliance 

Testing can only demonstrate the presence of defects, not prove their absence.  
The objective of testing is thus to find defects and the extent of that quest 

 is limited by economics. 
Software Quality And Productivity Guide, HP Corporate Engineering 

General 

No conformity test can prove the absence of any deviation from the format specification. The 
Conformity Test Software only proves the correctness of properties that are defined in the test tree. 
Therefore a successful test is not a 100% guarantee for a CADDY CD to be error free. 
The current software is capable to check CADDY 1.1 and CADDY 2.0 dossiers. 
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Dossier Versions 

The application allows the user to perform a format conformity test for a single version of a dossier. 
The test of dossier version "n" assumes that version "n - 1" was already tested successfully! 

CADDY Volumes 

The volumes are checked for proper label files and directory structure. 

The ISO 9660 conformity of the CDs is not checked by the CADDY Conformity Test Software and 
might be checked with other applications. 

Index Files 

Each index file is read line-by-line, analyzed for the general index file format and imported into an 
internal database for further analysis. The relations and constraints within this database are checked. 

Page Files 

Each page file is analyzed and checked for allowed and forbidden tags. 

The TIFF 6.0 conformity is not checked by the CADDY Conformity Test Software and might be 
checked with other applications. 

See also 
CADDY Conformity Test Software Overview 
CADDY Project History 
 

1.3 CADDY Project History 

At the beginning of 1995 a discussion about the development of an electronic dossier exchange 
standard for pesticides registration applications in Europe started. The need for standardization of an 
electronic format for the submission of pesticides dossiers is obvious. Representatives from regulatory 
authorities and industry expressed their strategic goal in the following statement: 

To facilitate 
 the provision of dossiers for pesticides to regulatory authorities, 
 the long-term archiving of such dossiers, 
 and the accessibility of information contained in such dossiers 

in a cost-effective manner using electronic media. 
The Joint EU Member States / ECPA Data Transfer Steering Group (DTSG) consisting of five experts 
of the EU and five experts of the ECPA registration task force was established in June 1995 to work 
out a solution to meet this strategic goal. 

 

CADDY Format Specification 

The CADDY Format Specification is a document that describes the CADDY standard. 
CADDY version 1.0 

The first version released was called CADDY 1.0. This version was a result of the discussion between 
EC, EU Member States and ECPA members about a common dossier interchange format on 
electronic media. The specification for CADDY 1.0 (Version 0.7, January 31,1996) was published after 
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being accepted by EC, EU Member States and ECPA. CADDY 1.0 was not used for compiling 
dossiers and is not supported any longer. 

CADDY version 1.1 
The second version, called CADDY 1.1, was released September 23, 1997. This enhanced version 
was created from CADDY 1.0 by adding some minor adjustments that makes it usable in the United 
States and Canada too. There was an addendum to the format specification CADDY 1.1 released on 
February 24,1998. CADDY 1.1 was used to submit European dossiers and must therefore be 
supported by all current CADDY viewers. 

CADDY version 2.0 
The current version is called CADDY 2.0. This enhanced version was created from CADDY 1.1 by 
adding some enhancements that were requested by European authorities. The format specification 
(CADDY 2.0) was enhanced by adding support for CADDY controlled files, CADDY hyperlinks and 
other features that were agreed upon by the Joint CADDY Steering Group. 
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2 Basic Concepts 

Test Areas 
Test Tree Concept 
Conformity Test Steps 
Test Tree States 

 

2.1 Test Areas 

The tests are grouped into test areas. These can be found within the test tree on the first hierarchy 
level. 

Volume Set Conformity (VSC) 

• Does content of label file corresponds to the format specification? 

• Is the directory structure on each volume correct? 

• Do the mandatory index files exist on the current index volume? 

Index File Syntax (IFS) 

• Does the syntax of all existing index files conform to the general index file format? 

• Import the index files of the current dossier version to the corresponding index tables. 
• Are fields declared as unique really unique? 

Index File Conformity (IFC) 

• Are the contents of the table 'Additional remarks on fields' (see Format Specification) fulfilled? 

• Is the entity relationship diagram (see Format Specification) for the dossier database fulfilled? 

• Are fields declared as unique really unique? 

Index File History Check (IFH) 

This test area is only applicable for dossier versions higher than 1 because a previous version is 
needed.  

• Import the index files of the previous current dossier version to the corresponding index tables. 

• Are all new entries in the changes history conform? 

• Is each history table of the previous version a subset of the corresponding history table of the 
current version?  

• Are flags for added items correct? 

File Completeness Check (FCC) 

• Do all page files exist on the right volumes? 
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• Do all controlled files exist on the right volumes? 

Page File Conformity (PFC) 

• Is the format of the page files (TIFF files) correct? 
For each volume of the current dossier version the format of the TIFF files is checked for CADDY 
conformity. The TIFF Tag Test LOG will contain a detailed list of the results. 

 
 

2.2 Test Tree Concept 

The idea behind the test tree concept is to build a hierarchy, where the result of a test depends on the 
results of all subordinate tests (sub-tests). A test at a higher level is successful if and only if all of its 
sub-tests are also successful. Each such sub-test is only a component of the whole test, i.e. a sub-test 
only covers a part of the scope to be tested at the higher level. 
A tree structure is suitable for representing this relationship between tests and sub-tests. Each node in 
the test tree represents one test. 

The root of the test tree represents the whole CADDY conformity test. For this test, all subordinate 
tests must be executed, i.e. the whole test tree must be traversed. The child nodes of the root are 
called Test Areas. The leaves of the tree are called Basic Tests (BT). They are the elementary 
components of their parent nodes and generally confined to the testing of elementary facts (e.g. 
syntax test of one index file). All other tests that are neither test areas nor basic tests are called Test 
Groups (TG). 
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The test tree concept allows the user to select and execute only a specific sub-tree of the test tree, 
making the testing process very flexible. It is a dynamic structure that allows to add tests during 
runtime. 
Two examples:  

• History checks: Two cases must be distinguished: In dossier version one the history check 
area (IFH) is missing, in higher versions it is part of the test tree. 

• TIFF tests: One basic test is created for each volume. 
In some cases, tests must be performed successfully before other tests can be started, e.g. if one test 
is based on the results of another. This fact must be considered before each test is executed; 
therefore preconditions are stored for every test. 

In other cases, before performing a test, preparatory operations must be performed (e.g. reading 
files). These preparatory operations are also considered tests. 

 

 

2.3 Conformity Test Steps  
Testing of a CADDY dossier version is done in four steps: 

Create New Test Tree 
For a dossier version that is to be tested a test tree must be created first. The properties of a 
test tree can be changed after creation (see Test Tree Properties). 

Read Volume Step 
During this phase all index files and label files are copied from the volume to the test tree 
directory. 

Performing Tests Step  
The selected tests from the test tree will be performed. 

Printing / Exporting Results Report 
Exporting or printing a result report should document the results. To avoid accidental changes 
of the test results the test tree can be protected (see Protect / Unprotect Test Tree). After the 
results were printed and/or exported the test tree can be deleted (see Delete Test Tree). 

 

See also 
Test Tree States 
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2.4 Test Tree States 

A test tree can have one of three states: 

 Not initialized 
 Testable 
 Protected 

 

Not Initialized 

After the test tree directory is created it will be in the state 'Not Initialized'. In this state the 
volumes have to be read to change the state to 'Testable'. If the read volume step fails, the test 
tree remains in the state 'Not initialized'. 

In this state instead of the Test Tree Display an additional button Read Volumes is visible in the 
application main window that will work like the menu item Read Volumes in the Run menu. 

Testable 

After the volumes were read successfully the test tree will be in the state 'Testable'. In this state 
tests can be performed by selecting the menu item Start Tests from the Run menu. If the user 
wants to reread the volumes this can be done by selecting menu item Read Volumes from the 
Run menu.  

Protected 

A test tree that is protected cannot be modified or deleted. The state can be toggled between 
'Protected' and 'Testable' by selecting the menu item Protection from the File menu. 

See also 
Conformity Test Steps 
Protect / Unprotect Test Tree 
Read Volume Step 

 



CADDY Conformity Test Software User’s Guide 
 

Hewlett-Packard GmbH  October 2, 2002 Page 11 of 45 

3 Usage 

Application Main Window 
Test Tree Display 
Main Menu 
Processes And Dialog Boxes 

 

3.1 Application Main Window 

The application main window is opened when the Conformity Test Software is started. It contains the 
main menu. 

The main window can look very different: 
No test tree is open 

There is no current test tree available. The main window is empty. Only a few menu items are 
available. 

Current test tree 'Not Initialized' 
If the current test tree is 'Not Initialized' the volumes must be read before testing is started. 
Instead of the test tree display a button Read Volumes is visible. 

Current Test Tree "Initialized" 
The test tree is displayed  

Tests are running 
During execution of tests the main window is partially hidden by a dialog box showing the test 
progress. 

 

3.2 Test Tree Display 

The test tree display in the main application window shows the hierarchical structure of the current test 
tree. 
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The information box on the bottom shows the test description of the current test and the result details 
of the last test. the plus symbol indicates that there are hidden subordinate tests. 
The minus symbol indicates that all subordinate tests are visible. The user can toggle between 
showing and hiding subordinate tests by mouse clicking on the plus/minus symbols. 

 

The following menu items from the View menu can also be used to change the visibility of 
subordinated items in the test tree: 

Expand Branch This option opens the selected test branch in the current test tree. The 
branch is opened to all "leaf" nodes of the selected test, i.e. to the 
deepest level of all of its sub-tests. 

Expand Next Level This option opens the next level of the selected test in the current test 
tree. The test is only opened to the next level of sub-tests of the selected 
test. 

 Accelerator:  Click plus symbol of the chosen test. 

Hide Branch This option closes (hides) the next level of the selected test in the current 
test tree. Sub-tests of the selected tests are removed from the display of 
the test tree. 

 Accelerator:  Click minus symbol of the chosen test. 
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The test result icon is shown: 

 A check mark is shown when test was successfully done. 

 A warning sign is shown when a basic test failed or when one of the sub tests failed. 

 A question mark is shown then the test was not performed because a precondition failed. 
 A question mark is shown then the test was not performed 

 (e.g. a precondition of a parent test failed or test was not selected for execution). 
The user can select tests to execute by clicking with the mouse within the squares in front of the test 
items. A selected item can be deselected by clicking on the check boxes. 

 Item is not selected 

 Item is selected 
When selecting tests, it must be remembered that tests are only executed if the execution of the 
respective precondition tests was successful. Therefore, the user must ensure that any precondition 
tests are also selected prior to beginning of test execution. The preconditions of each test are stored 
in the test tree. 

If the complete CADDY conformity test is to be executed, it is sufficient for the user to select the root 
node of the current test tree. 

Additional Notes 

 If reading of the volumes failed (e.g. it was canceled by the user) a button Read Volumes is shown 
instead of the test tree. 

 

3.3 Main Menu 

The following menus are available: 

 

Menu File 
Menu View 
Menu Run 
Menu Options 
Menu Help 

 
Menus and menu items, which are not applicable, are grayed out. 
 

3.3.1 Menu File 

The following menu items can be found within the File menu: 
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New Create a new test tree. 

Open Open an existing test tree. 

Close Close the current test tree. 

Delete Delete the current test tree. 
Protection Protect / Unprotect the current test tree. If a checkmark is shown at this 

item, the test tree is protected and selecting this menu item will cause to 
unprotect the test tree. 

Properties Show / Edit current test tree properties. 

Export Export the result report to file. 

Print Print the result report. 

Print Setup Open the standard print setup dialog box. 

Exit Close the application. 

See also 
Main Menu 

 

3.3.2 Menu View 

The following menu items can be found within the View menu: 
Expand Branch All subordinated items of the currently selected test are shown. 
Show Next Level All subordinated items on next level are shown. 

Hide Branch All sub items of the currently selected test are hid. 

See also 
Main Menu 
Test Tree Display 

 

3.3.3 Menu Run 

The following menu items can be found within the Run menu: 
Start All Tests Select root node and start executing all tests. 
Start Selected Tests Start executing the selected tests. 
Clear Test Results Clear all results of previous tests. 
Read Volumes Read volumes from original media. 

See also 
Main Menu 
Conformity Test Steps 
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3.3.4 Menu Options 

The Options menu contains no menu items and opens the dialog box Options when selected: 

See also 
Main Menu 
Dialog Box Options 
 

3.3.5 Menu Help 

The following menu items can be found within the Help menu: 
Contents Opens the On-line Help Content Page. 

Search For Help On 
Opens the Microsoft Help Search dialog box and allows the user to select 
a help topic. 

CADDY Format Specifications 
Opens the PDF-Viewer (if installed) and displays the format specification 
1.1 and 2.0. 

About CADDY Conformity Test 
Displays the copyright and software version of the CADDY Conformity 
Test Software. 

See also 
Main Menu 
 

3.4 Processes and Dialog Boxes 

The following processes are implemented within the Conformity Test Application: 
Starting Conformity Test Software 
Create New Test Tree 
Open Existing Test Tree 
Close Test Tree 
View / Edit Test Tree Properties 
Read Volumes Step 
Performing Tests Step 
Protect / Unprotect Test Tree 
Printing / Exporting Result Report 
Delete Test Tree 
Quitting Conformity Test Software 

Dialog Boxes 

The following dialog boxes will appear within the application: 
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New Test Tree 
Open Test Tree 
Test Tree Properties 
Reading Volumes 
Insert Volume 
Test Progress 
Options 
Export Result Report 
Print Result Report 
Print Setup 
About 
 

3.4.2 Starting Conformity Test Software 

Start the CADDY Conformity Test application using the standard conventions appropriate for your 
version of Windows.  

 

To open Conformity Test application: 

 
 Click Start > Programs > CADDY > Conformity Test 
 

The application main window is opened in the middle of the screen. 
 

3.4.3 Create New Test Tree 

This process allows to create a new test tree. The dialog box New Test Tree is opened by selecting 
the menu item New from menu File.  

The user must enter the volume set ID, the dossier version number and the format of the dossier 
(CADDY 1.1 or CADDY 2.0). The  test tree name is created from the input fields Volume Set ID and 
Dossier Version after pressing the OK button. 

Default values are provided for the tester's name and organization. These default values are retrieved 
from the registry. The user may edit the values. 

Upon confirmation by the user, a new test tree is created. First, the test tree directory in the working 
directory is created. If the test tree directory was already existing, a new test tree cannot be created 
and a warning message is displayed.  
If another test tree was already open, it is closed automatically before the new test tree is opened and 
displayed in the application main window. 
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Buttons 
OK Create a new test tree and open dialog box Insert Volume. 
Cancel Close dialog box without creating a new test tree. 
Select Dossier Open dialog box Select Dossier Label File to read label file of index volume 

and set the required dossier input values. 

Fields 
Volume Set ID CADDY volume set ID. (input mandatory) 
Dossier Version CADDY dossier version. (input mandatory) 
Format CADDY format  (valid values: CADDY 1.1 and CADDY 2.0) (input 

mandatory) 
User Name Name of the person that is performing the test. (optional input) 
Organization Organization of the person that is performing the test. (optional input) 

 

3.4.4 Open Existing Test Tree 

This process allows choosing an existing test tree to be opened. The dialog box Open Test Tree is 
opened by selecting the menu item Open from menu File. 
The user is allowed to open one of the existing test trees. All existing test tree names are shown in 
alphabetical order. The user can choose one of them 
If another test tree is already open, it is first closed. Then the chosen test tree is opened and the 
hierarchical structure is shown in the test tree display (if test tree state is 'Testable' or 'Protected'). 
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Buttons 
New Open the dialog box New Test Tree. 
Delete Delete selected test tree. 
Open Open selected test tree. 
Cancel Close dialog box without opening a test tree. 

 

Double clicking with the mouse on a test tree item will open this test tree. (Same as highlighting an 
item and pressing OK button) 

 

3.4.5 Close Test Tree 

The current test tree can be closed. In this case no test tree remains open and the application main 
window will be empty. Only a few menu items are available to open an existing test tree or to create a 
new one. 

 

3.4.6 View / Edit Test Tree Properties 

This dialog box is used for viewing and changing test tree properties. Selecting the menu item 
Properties from the File menu opens it. 
If the current test tree is protected this dialog box will not allow to change settings. Instead of the OK 
and Cancel button a Close button is displayed. 
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Buttons 
OK Save changes and close dialog box. 
Cancel / Close Close dialog box without saving changes. 

Fields 
User Name Name of the person that has performed the test. 
Organization Organization of the person that has performed the test. 
Test Begin Date and time of first test that was executed. 
Test End Date and time of last test that was executed. 
Volume Set ID CADDY volume set ID. 
Dossier Version CADDY dossier version. 
Format CADDY format (either CADDY 2.0 or CADDY 1.1). 

 

3.4.7 Protect / Unprotect Test Tree 

The current test tree can be protected to avoid accidental changes. The menu item Protection in menu 
File will toggle between the test tree states 'Protected' and 'Testable'. If the current test tree is 
protected, a checkmark is shown at the menu item. 

 

3.4.8 Read Volumes Step 

This process is started by selecting the menu item Read Volumes from the Run menu or by pressing 
the button Read Volumes in the application main window. 
The dialog box Reading Volumes is opened that records all actions. In addition the dialog box Insert 
Volume is opened requesting to insert the index volume of the dossier version to test. Follow the 
instructions within the dialog boxes and the message boxes that appear if the label file on the inserted 
volume cannot be read. 
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During the read volumes step all index files and label files are copied from the volume to the test tree 
directory. The content of the directories FILES and PAGES is not copied, but recorded within the test 
tree database for later analysis. 

See also 
Conformity Test Steps 

 

3.4.8.2 Reading Volumes 

This dialog box logs all system actions and results that are done during the read volume step. All lines 
shown in the list box will be written into a log file during operation. 

 

Buttons 
Close Close dialog box. 
Start Tests Close dialog box and start all tests. This button is greyed out if an error 

occurred. 
 

3.4.8.3 Dialog Box Insert Volume 

This dialog box asks the user to insert a CADDY volume and to specify the path to the root directory of 
this volume. It is shown whenever the application needs to access a volume and this volume is not 
already available. 

There are two situations when this can happen: 
 The volume should be read during the read volume step 
 The page file conformity (tag test) should be checked. 
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Buttons 
OK Confirm insertion of volume. 
Cancel Close dialog box and cancel operation. 

When the Insert Volume dialog box is displayed, the user is asked to choose the directory where the 
requested volume data is stored. The drive letter can be selected from the drive list. All directories of 
the current drive are displayed in the directory list. Subdirectories at the next level can be displayed by 
double clicking on a directory item in the list. 

During read volume step: 
After the OK button was pressed the dialog box might immediately be shown again to request the next 
volume. If the dialog box is canceled it is necessary to reread all volumes of the current version, 
because the test tree stays in state 'Not-Initialized'. 
 

3.4.9 Performing Tests Step 

This process is started by selecting the menu item Start Tests from the Run menu. The selected tests 
defined by the test tree will be performed. The application main window is closed while the dialog box 
Test Progress is opened. All test results obtained during this phase will be stored within the test tree 
database. 
 

3.4.9.1 Dialog Box Test Progress 

The dialog box Test Progress is displayed during execution of the test tree. It can appear in different 
modes: 

Execution Mode The test process is currently running. The user can choose button 
Stop to enter pause request mode. 

Pause Request Mode The user has pressed the button Stop. The current test is finished 
before pause mode is entered automatically. 
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Pause Mode The test process is suspended. The user can choose button Resume 
to resume the test process or button Cancel to abort testing. 

Testing Finished When testing is finished the user can press button OK to close the 
dialog box. 

 

The layout and the appearance of the buttons differ from variant to variant. 

 

Progress Bars 

The main progress bar that is displayed at the top of the dialog box shows the percentage of tests 
that are executed. 

The basic test progress bar at the bottom of the dialog box shows the percentage of basic 
operations within one basic test that are done. This progress bar is only shown if more than a certain 
number of basic operations are to be done within one basic test. (Example: Reading of the page table 
contains the basic operation read character. The basic test progress bar shows the percentage of 
characters read from the index file dc_pag; this is not done for all index files, but only for larger ones.) 

Fields 
Elapsed Time Time that was elapsed during execution of tests. 
Remaining Number of tests that have not been executed yet. 
Skipped Number of tests that were skipped because their precondition was not 

fulfilled. 
Failed Number of tests whose execution failed. 
Successful Number of successful tests. 
Test Area Test area where the current test belongs to. 
Test ID Test ID of the current basic test. 
Basic Test Title of the current basic test. 
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3.4.9.2 Test Progress: Execution Mode 

This dialog box is shown during execution of the tests. 

Buttons 
Stop In execution mode this button allows switching to pause request mode. 

Pause mode is not entered immediately but after execution of the current 
test. 

 

3.4.9.3 Test Progress: Pause Request Mode 

Instead of the Stop button in execution mode a text "Testing will be stopped after executing the current 
test" is displayed. The user has to wait until the dialog box changes to pause mode after the current 
test is finished. 
 

3.4.9.4 Test Progress: Pause Mode 

This variant is displayed when the user stopped testing. 

Buttons 
Resume Change to execution mode and resume the test process with the next test. 
Cancel Close the dialog box without initiating any actions. 

 

3.4.9.5 Test Progress: Testing Finished 

This variant is displayed at the end of the test process. The caption of the dialog box is changed to 
"Test is finished". The frame Current Test is not visible. Instead of the Stop button an OK button is 
displayed. The user has to confirm the dialog box before it is closed. 

Buttons 
OK Close the dialog box. 

 
 

3.4.10 Printing / Exporting Result Report 
The Conformity Test Software allows creating a detailed report of the test tree content and the test 
results. This report has the same hierarchical structure as the test tree. It can only be generated 
complete, it is not possible to generate reports for parts of the tree. 

The result report can be exported to a file or printed: 
 Export Result Report 
 Print Result Report 

Example Result Report: 
CADDY Conformity Test
-------------------------

Volume Set ID: CAYBE004 Version: 5 Format: CADDY 2.0
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Test Begin: 10.07.2002 19:34 Test End: 10.07.2002 19:34

Test Software: Version 2.0 Rev. 20 / October 2002

Tester
------

User Name: Michael Gross
Organization: Hewlett-Packard

Test Results
------------

CCC CADDY 2.0 Conformity Test Failed
Info: Test of a child node failed.

-------------------------------------------------------------------------------------

VSC Volume Set Conformity Failed
Info: Test of a child node failed.

-------------------------------------------------------------------------------------
LAB Syntax test and content of label files Failed

Info: Test of a child node failed.
RDX Read all label files Failed

Line 1 in label file on volume 7 is empty.
VOL Check volume info in label file PreCond

Precondition CCC.VSC.LAB.RDX failed.
CON Check info lines in label file PreCond

Precondition CCC.VSC.LAB.RDX failed.
DIR Conformity of directory contents OK

ROO Conformity of root directories OK
PAG Conformity of PAGES directories OK
CCF Conformity of CCF directories OK
IDX Conformity of INDEX directory OK

MIF Existence of mandatory index files OK

IFS Index File Syntax Checks Failed
Info: Test of a child node failed.

-------------------------------------------------------------------------------------
FSC Syntax check and import of all index files OK

VER Syntax check of version history OK
.
.
. 
 

3.4.10.2 Dialog Box Export Result Report 

This dialog box allows exporting a result report to a file. The user can select a directory and provide or 
select a filename where result report will be written as text file. 
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This dialog box is the Microsoft common dialog "Save as" that is operating system specific and may 
look different on your computer system. If you need help, refer to the Microsoft documentation. 
 

3.4.10.3 Dialog Box Print Result Report 

This dialog box allows printing of a result report. 

 

Buttons 
Print Close dialog box and start printing. 
Print Setup Open the standard print setup dialog box. 
Cancel  Close dialog box without printing a report. 

 

3.4.10.4 Dialog Box Print Setup 

This dialog box allows to change the print setup. It is opened by selecting the menu item Print Setup 
from the menu File or by pressing the Print Setup button in the dialog box Print Result Report. 

 

or 
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This dialog box is the Microsoft common dialog "Print Setup", that is operating system specific and 
may look different on your computer system. If you need help, refer to the Microsoft documentation. 

 

3.4.11 Delete Test Tree 

The current test tree can be deleted by selecting the menu item Delete from the File menu. Deletion is 
only possible if the test tree is not protected. Before a test tree is deleted the user is asked for 
confirmation. Deleting a test tree will simply delete the test tree directory with all files and sub 
directories contained in it.  

 

Buttons 
Yes The test tree will be closed and the test tree directory will be deleted. 
No Test tree remains open and will not be deleted. 

 

See also 
Test Tree Protection 

 
Dialog Box Options 
This dialog box allows to change the program settings. These settings will be stored in the windows 
registry. 

 
There are four tabs to choose from. 

User Tab 
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Print Tab 
Report Tab 
Directories Tab 
 

Buttons 
OK Store all settings and close dialog box. 
Cancel Close dialog box. 
Apply Store all settings without closing the dialog box. 

 
Dialog Box Options: Tab User 
The dialog box Options allows to change the program settings. These settings will be stored in the 
windows registry in section Tester. 

The tab User allows to preset values for user name and organization. 

 

 

 

Buttons 
OK Store all settings and close dialog box. 
Cancel Close dialog box. 
Apply Store all settings without closing the dialog box. 

 

See also 
Print Tab 
Report Tab 
Directories Tab 
 

Dialog Box Options: Tab Print 
The dialog box Options allows to change the program settings. These settings will be stored in the 
windows registry in section Print. 
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The tab Print allows to define settings for printing of reports. 

 

 

 

Buttons 
OK Store all settings and close dialog box. 
Cancel Close dialog box. 
Apply Store all settings without closing the dialog box. 

 

See also 
User Tab 
Report Tab 
Directories Tab 
 

Dialog Box Options: Tab Report 
The dialog box Options allows to change the program settings. These settings will be stored in the 
windows registry in section Report. 
The tab Report allows to define the width of the reports. 
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Buttons 
OK Store all settings and close dialog box. 
Cancel Close dialog box. 
Apply Store all settings without closing the dialog box. 

 

See also 
User Tab 
Print Tab 
Directories Tab 

 
Dialog Box Options: Tab Directories 
The dialog box Options allows to change the program settings. These settings will be stored in the 
windows registry in section Directories. 
The tab Directories allows to predefine paths for working directory and volume directory. 
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Buttons 
OK Store all settings and close dialog box. 
Cancel Close dialog box. 
Apply Store all settings without closing the dialog box. 

 

See also 
User Tab 
Print Tab 
Report Tab 
 

3.4.12 Dialog Box About 
This dialog box displays the software version and copyright notice. The hyperlink to the CADDY 
homepage will open the web browser. 

 

Buttons 
OK Close dialog box. 

 

3.4.13 Quitting Conformity Test Software 

Use menu item Exit from the File menu, or double-click on the upper left-hand corner System Menu 
Box to close the Conformity Test application.  



CADDY Conformity Test Software User’s Guide 
 

Hewlett-Packard GmbH  October 2, 2002 Page 31 of 45 

When the application is closed no additional confirmation from the user is requested. Saving data is 
not necessary because all test results are automatically saved after each basic test is executed. 
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4 Other Topics 

Messages And Questions 
Configuration Settings in Windows Registry 
Structure Of Working Directory 
Content Of Application Directory 
Log Files 
Hardware And Software Requirements 
Installation 
Removing Conformity Test Software 
 

4.1 Messages And Questions 

Messages 

The Conformity Test Software may display different types of messages: 
info: Notifies the user about important events. 

warning: Notifies the user about important events that might cause unexpected system 
behavior later. 

error: Notifies the user about error events in the application. The application will be able 
to recover from this error. The user can resume with his work. 

system error: Notifies the user about an unrecoverable error. The application will terminate. 
During execution of this application you may encounter one of this system error 
messages. Most are recoverable by the user, with little effort. 

Questions 

In addition to these message types, there is a confirmation message type which requests a 
confirmation from the user before an irrevocable action is performed: 

question: Notifies the user that an action that cannot be revoked will be performed after 
confirming this message. 

 

4.2 Configuration Settings in Windows Registry 

To store the program settings the MS-Windows registry is used. The user should not modify the 
registry directly. Instead, the settings can be changed using the options dialog of the Conformity Test 
Software. 
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The settings are stored in HKEY_CURRENT_USER\Software\VB and VBA Program Settings\CADDY 
ConfTest 
 
The following sections are available: 

• Section [Directories] 
• Section [Tester] 
• Section [Report] 
• Section [Print] 

 

None of the sections is changed by the application itself. 

Section [Directories] 

All configured directories are stored in this section. The directory names within this section can be 
changed to reflect the situation of the current installation. 

WorkingDir = p no default; a system error occurs when invalid; when empty, the value 
of ProgDir is used 
The working directory is used to store the template database and local 
data files. 

VolumeDir = p no default; a system error occurs when invalid 
This directory is used for the access to CADDY volumes. 

Example: 
WorkingDir=C:\CTSW\DATA 

VolumeDir=D: 

Section [Tester] 

The values stored in this section will be used as defaults when a new test tree is created. The user 
should set these values after installation. 

UserName = us us: user name (after installation this setting is empty) 

Organization = os os: organization name (after installation this setting is empty) 
 
Example: 

UserName=Michael Gross 

Organization=Hewlett-Packard 

Section [Report] 

The user has to be careful when theses settings are changed. Changes will influence exported and 
printed result reports 

ReportWidth = rw rw: maximum number of characters per report line 
(Default: rw = 85) 

Section [Print] 
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The user has to be careful when theses settings are changed. Changes will influence printed result 
reports 

MarginTop= mt mt: vertical coordinate for the top edge (mm) 
(mt = 10) 

MarginBottom= mb mb: vertical coordinate for the bottom edge (mm) (from paper bottom 
edge) 
(mb = 10) 

MarginLeft=ml ml: horizontal coordinate for the left edge (mm)  
(Default: ml = 10) 

MarginRight=mr mr: horizontal coordinate for the right edge (mm) (from right paper 
edge) 
(Default: mr = 10) 

FontSize=fs fs: font size (points) 
(Default: fs = 10) 

FontName =fn fn: name of printer font 
(Default: fn = COURIER NEW) 

 

4.3 Structure Of Working Directory 

For each dossier version, a subdirectory named like the test tree name is created in the working 
directory. This subdirectory is called the test tree directory. The template database is copied to the test 
tree directory when a test tree is created. Each test tree directory contains subdirectories, which are 
named according to the volume numbers of the respective dossier version. The corresponding volume 
data (label file, index files) are copied to these volume subdirectories during the read volumes step. 

Example Structure of Working Directory 
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DATA

BAYDE001.002

004

005

label.txt

label.txt

Index

conftst.mdb

DOEGB003.001

Example Data Directory Tree
(Only part of the tree is shown)

Conformity Test SW

conftst.mdb

dd_tab

dd_col

conftst.mdb

 

 

4.4 Content Of Application Directory 

The Setup program will create during installation an application directory containing the following files: 
Program Files 

CONFTST.EXE Executable file 
CONFTST.HLP Online Help file 
CONFTST.CNT Online Help Contents file 
CONFTST.MDB Template Database 

Information Text Files 
README.TXT Installation notes and content of distribution package 
LICENSE.TXT Freeware License Agreement 
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Documentation Files 
FS_SE.PDF CADDY Format Specifications 1.1 and 2.0 
UGUIDE.PDF Conformity Test Software User's Guide 

 

4.5 Log Files 

As they might flood the test tree and cover a lot of pages (more than 1000 lines) in the result report 
the result details of the some actions are recorded in log files:  

 Read Volumes Log (log file for tracking all actions during the read volume step) 
Name of log file:  Test Tree Directory + "\reading.log" 
e.g.: C:\CADDY\CONFTST\DATA\CAYBE002.002\reading.log 

 Syntax Check Log (log file for syntax check and import of index files) 
Name of log file:  Test Tree Directory + "\" + name of index file + ".log" 
e.g.: C:\CADDY\CONFTST\DATA\CAYBE002.002\dc_pag.log 

 TIFF Tag Test LOG (log file for details on TIFF tag test of page files) 
Name of log file: Test Tree Directory + "\pagtst" + number of volume + ".log" 
e.g.: C:\CADDY\CONFTST\DATA\CAYBE002.002\002\pagtst001.log 

 

4.6 System Requirements 

The minimum requirements to run the CADDY Conformity Test Software are: 

 
 Computer / Processor: an Intel compatible PC (Pentium processor recommended) 
 Main Memory: the minimum RAM recommended by the manufacturer of your operating 

system 
 Hard Disk: at least 10 MB free disk space (data and program files) on local hard disk or 

network drive 
 Display: VGA or higher resolution graphics adapter and matching monitor 

Note: screen resolution 480 x 640, screen size 14" 
 Peripherals: CD-ROM drive and printer 
 Mouse or other pointing device. 
 Microsoft 32-bit Windows operating system:  

Windows 95, Windows 98, Windows Me, Windows NT 4.0 or Windows 2000  
with the latest Microsoft patches installed 

 Microsoft MDAC-Patch (including MS JET-Database Engine) installed (available on the 
Microsoft homepage) 

 
To view the online documentation you need: 

 
 Adobe Acrobat Reader version 4.0 or higher installed on your PC 
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4.7 Installation 

Important: Before installation is started all other running applications should be closed. 
Start the installation process using the standard conventions appropriate for your version of Windows. 

 
 Example: Choose Run from the Start menu, type "a:setup", and press the Enter key. 

(Instead of "a:" use the appropriate directory where the installation package file of the 
distribution package can be found.) 

 

The Setup program will issue a number of prompts. Unless you have a reason to override the defaults 
it is recommended that you accept the installation default settings (just press OK, Yes, or Next, as 
appropriate).  

 
By default, the application is installed in a sub-directory/folder (application directory) of the windows 
Program Files directory named "CADDY Conformity Test 2.0". You may change this default path 
during the installation process. In addition some support files will be installed within the Windows 
System directory. 

If you have problems with the installation, check to see if your device drivers and DLL files are current. 
Updating drivers and DLL files to the latest versions will fix most problems. 
 
Please refer to readme.txt for further installation notes. 
 

Conformity Test Software requires MDAC 

Because of database changes made in order to open possibilities of using other database types (such 
as SQL or Oracle) in future versions and to make Conformity Test Software Windows 2000 
compatible, Conformity Test Software now requires that MDAC 2.5 or higher be installed (MDAC is 
Microsoft Data Access Controls). The Conformity Test Software installation will not run if MDAC is not 
installed. You can download the MDAC setup from the Microsoft web site at: 

 
http://www.microsoft.com/data/download.htm 

 
MDAC 2.6 does not contain all the components necessary to run Conformity Test Software  If you 
wish to use MDAC 2.6 you must install MDAC 2.5 first and then upgrade, or you must also install the 
Jet Database components. You can download Jet from the Microsoft website. 

 
To install correctly on a Windows 95 computer, MDAC requires that DCOM95 be installed. MDAC 
installs components that rely on DLLs installed by DCOM95 in order to register correctly. Note that 
DCOM95 is not required on a Windows NT 4.0. In some cases, DCOM may not be installed on a 
Windows 98 computer. If it has not been installed, then DCOM98 should be installed prior to the 
installation of MDAC. DCOM95 and DCOM98 are also available on the Microsoft website. 

 

MDAC 2.5 and later require that Internet Explorer (version 4.01 or higher) is installed on the machine 
as well. We regret the necessity of requiring IE in order to run Conformity Test Software, but there was 
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little choice if we wanted to be able to become Windows 2000 compliant. You do not need to use IE as 
your default browser, but it needs to be installed in order to update certain system components to 
required versions. We apologize for any inconvenience. You can download IE 5 from:  

 

http://www.microsoft.com/windows/ie/default.htm 

 

See also 
Removing Conformity Test Software 
Content of Application Directory 
Installed Support Files 

 

4.7.2 Installed Support Files 

The Setup program will place some support files to the Windows System directory. 
Due to the nature of Visual Basic and the OLE architecture, the used OCX controls require that some 
support files are installed in your system directory. They might be shared with other applications. 
The following table gives a brief description of the files that may have been installed on your hard disk 
during the Setup process. 

Filename(s) Description 

Active-X Controls 
COMDLG32.OCX Support OCX 
MSCOMCTL.OCX Support OCX 
TABCTL32.DLL Support OCX 

Microsoft Jet Database Engine 
DAO360.DLL Support DLL (Microsoft Jet DAO Library) 

Microsoft OLE Support 
STDOLE2.TLB Support file (OLE Automation Type Library) 
OLEAUT32 Support DLL (OLE DLL) 
OLEPRO32.DLL Support DLL (OLE DLL) 
ASYNCFILT.DLL Support DLL (OLE DLL) 
COMCAT.DLL Support DLL (OLE DLL) 

Microsoft Visual Basic Runtime Support 
MSVBVM60.DLL Visual Basic Runtime DLL 

Other Support Files 
CADDYImportExport.dll    CADDY Conformity Test Support DLL 

See also 
Installation 
Removing The Conformity Test Software 

 



CADDY Conformity Test Software User’s Guide 
 

Hewlett-Packard GmbH  October 2, 2002 Page 39 of 45 

4.8 Removing Conformity Test Software 

To remove the Conformity Test Software you should open Add/Remove Programs in Control Panel of 
your windows operating system. 

See also 
Installation 
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5 Freeware License Agreement 

You should carefully read the following terms and conditions before using this software. Unless you 
have a different license agreement signed by Hewlett-Packard your use of this software indicates your 
acceptance of this license agreement and warranty. 
A copy of this license agreement can be found in the file RELEASE.TXT that is contained in the 
distribution package. 

INSTALLATION OR USAGE OF THIS SOFTWARE PACKAGE ON YOUR COMPUTER SYSTEM 
IMPLIES AGREEMENT WITH THE TERMS AND CONDITIONS BELOW. 

General 
 CADDY Conformity Test Software is a FREEWARE package: It can be freely copied and 

distributed under the terms of the licensing agreement within this document. 
 CADDY Conformity Test Software and its documentation are copyright (c) 1997 - 2002 by 

Hewlett-Packard GmbH, Germany, all rights reserved.  
 CADDY Conformity Test Software may not be circulated in any incomplete or modified form, 

nor sold for profit, without written permission of Hewlett-Packard. 
 
Distribution and/or use is permitted under the following terms: 
In the interest of promoting the use and popularity of CADDY people are asked to copy this program 
freely. Even so, this is not public domain software and Hewlett-Packard owns the copyrights to this 
material.  

If you distribute this software to others, you are required to distribute the ENTIRE package including 
all files belonging to the distribution package. 

You may copy and distribute verbatim copies of the CADDY Conformity Test Software and 
documentation as you receive it, in any medium, provided that you conspicuously and appropriately 
publish on each copy a valid copyright notice "Copyright (c) Hewlett Packard GmbH", and keep intact 
the notices on all files that refer to these Licensing Terms and to the absence of any warranty. 

The CADDY Conformity Test Software and associated documentation may not otherwise be modified, 
sold, or used as part of a commercial package without the express permission of Hewlett-Packard. 

The CADDY Conformity Test Package is copyrighted material and is subject to limitations by Hewlett-
Packard as to its use and distribution. You may use the software; make copies of the software; give 
copies to anyone; and distribute it via electronic means. There is no charge for this software, but you 
must include a copy of this document with any copies that you make. 

You are specifically prohibited from charging or requesting donations for any copies; from modifying 
the software and from distributing the software with commercial products without prior written 
permission. 

Warranty and Liability 

There is no warranty of any kind given, either expressed or implied, including, but not limited to, the 
implied warranties of fitness for a particular purpose.  



CADDY Conformity Test Software User’s Guide 
 

Hewlett-Packard GmbH  October 2, 2002 Page 41 of 45 

CADDY Conformity Test Software is provided "as is" without warranty of any kind, either expressed or 
implied, including but not limited to, the implied warranties of merchantability and fitness for a 
particular purpose. The entire risk as to the quality and performance of CADDY Conformity Test 
Software, and the accuracy of it's associated documentation, is with you. 

In no event will Hewlett-Packard, or any other party who may redistribute the program as permitted 
below, be liable to you for damages, including any general, special, incidental or consequential 
damages arising out of the use or inability to use the program (including but not limited to loss of data 
or data being rendered inaccurate or losses sustained by you or third parties or a failure of the 
program to operate with any other programs), even if such holder or other party has been advised of 
the possibility of such damages. 

UNDER NO CIRCUMSTANCES WILL HEWLETT-PACKARD BE LIABLE FOR ANY DAMAGES 
WHICH RESULT FROM THE USE OF THIS SOFTWARE PACKAGE OR THE INABILITY TO USE IT. 
EXCLUSION FROM LIABILITY INCLUDES, BUT IS NOT LIMITED TO, LOST PROFITS, LOST 
SAVINGS, OR ANY OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES. 

Usage, Duplication and Modification Policy 

You may use and copy CADDY Conformity Test package free of charge, but only when the following 
conditions are met: 

 NEVER change copyright statements: the copyright remains with Hewlett-Packard. 
 Neither the program nor the source, nor modified versions of either, may be sold or hired. 
 You may not modify or disassemble CADDY Conformity Test Software, nor distribute any 

modified or disassembled versions of CADDY Conformity Test Software. CADDY Conformity 
Test Software may not be included with any other product without written permission from 
Hewlett-Packard. 

Distribution Policy 

You can distribute the CADDY Conformity Test package under the following conditions: 

 ALL original files are distributed together. 
 You ask no contribution from the receiver of this utility package except for a nominal copying 

charge. You may charge a distribution fee for the physical act of transferring a copy, but no 
more than is necessary to recover your actual costs incurred in the transfer. 

 This program and associated files may be posted on any BBS without charge or permission. 
CADDY Conformity Test Software may be included in a companion disk with any book or 
magazine, and included in any shareware library, as long as the program and associated 
documentation are not modified. 
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6 Technical Support 

The CADDY World Wide Web homepage provides general information on CADDY. Included is the 
latest release of the Conformity Test Software as well as the latest patches and product information. 

http://www.ecpa.be/caddy 
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8 Glossary 

Current Test Tree 
Main Database 
Precondition 
Application Directory 
Protected Test Tree 
Result Report 
Test Tree Name 
Test Tree Directory 
Test Tree Database 
Working Directory 
 

Current Test Tree 
Tests are organized hierarchically. The test of one CADDY version is called a test tree. The 
current test tree is the opened test tree. Only one test tree is current at a time and its structure 
is displayed in the application window. If no test tree is current, only the menu is displayed and 
the application window is empty. 

 
Template Database 

The template database acts as a class when a Test Tree instance is created. The instances of 
the class are stored in files named testtree.mdb that can be found in the working directory. The 
file CONFTST.MDB is used read only during normal operation of the Conformity Test Software. 
 

Precondition 
A precondition is a test that must be done successfully before the current test can be done. 
Preconditions are defined within the test tree to ensure that e.g. a index file was read 
successfully before the data contained in it is analyzed. 
 

Application Directory 
The application directory of the Conformity Test Software is the directory where 
CONFTST.EXE was started from. It contains the program and documentation files and is 
created during installation. 

  Example: C:\Program Files\CADDY\CADDY Conformity Test 2.0 
 

Protected Test Tree 
A test tree that is protected cannot be changed any more. The test tree state is set to 
'Protected'. 
 

Result Report 
A result report is a detailed report of the test tree content and the test results. This report has 
the same hierarchical structure as the test tree. It can be exported to a file or printed. 
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Test Tree Database 

The test tree database contains the test tree table, the test options table, the data dictionary 
reference and all index tables of the current and the previous CADDY dossier version. The test 
tree database is stored within the test tree directory. 

 
Test Tree Directory 

The test tree directories  will contain all results and data necessary to test a dossier version. 

The name of this directory is build as follows: 

  [Test Tree Directory] ::= : Working Directory + "\" + Test Tree Name 

  Example: C:\CONFTST\DATA\CAYBE002.002 
 

Test Tree Name 
Test tree names are given to instances of Test Trees. The names are built by the ID of their 
corresponding volume set and the dossier version number. 

  [Test Tree Name] ::= [volume set ID] ‘’.’’ [version number] 

  Example : CAYBE002.002 
 

Working Directory 
The working directory of the Conformity Test Software is defined within the windows registry. 
It contains the test tree directories. 

  Example: C:\CONFTST\DATA 
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